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File menu commands

The File menu offers the following commands:

New Creates a new document.
Open Opens an existing document.
Close Closes an opened document.
Save Saves an opened document using the same file name.
Save As Saves an opened document to a specified file name.
Export File Export the file to text or database format.
Import File Import a text file.
Print 
Preview

Displays the document on the screen as it would appear printed.

Page Setup Selects headers and footers.
Print Setup Selects a printer and printer connection.
Exit Exits DeskTools.



Edit menu commands

The Edit menu offers the following commands:

Undo Reverse previous editing operation.
Cut Deletes data from the document and moves it to the 

clipboard.
Copy Copies data from the document to the clipboard.
Paste Pastes data from the clipboard into the document.
Delete Clear current selection.



Data menu commands (Telephone Lists) 

The Data menu for Telephone Lists offers the following commands:

Preferences Set preferences for this particular list.
Set Printer Font Set the font used by the printer.
Set Dial Settings Set settings for dialing out.
Merge Merge two telephone lists.

Telephones menu commands 

The Telephones menu offers the following commands:

Add Add a new item to the list.
Delete Delete an item from the list.
Find Find items in the list.
Show List Toggle to show previously find query, or show entire list.

Data menu commands (Glossary Lists) 

The Data menu for Glossary Lists offers the following commands:

Preferences Set preferences for this particular list.
Set Printer Font Set the font used by the printer.
Merge Merge two glossary lists.

Glossaries menu commands 

The Glossaries menu offers the following commands:

Add Add a new item to the list.
Delete Delete an item from the list.
Find Find items in the list.
Show List Toggle to show previously find query, or show entire list.

Data menu commands (Reminder Lists) 

The Data menu for Reminder Lists offers the following commands:

Preferences Set preferences for this particular list.
Set Printer Font Set the font used by the printer.

Reminders menu commands 

The Reminders menu offers the following commands:

Add Add a new item to the list.
Delete Delete an item from the list.
Find Find items in the list.



Todo menu commands 

The To-do menu offers the following commands:

Add Add a new item to the list.
Delete Delete an item from the list.
Check Check items in the list.

Calendar menu commands 

The Calendar menu offers the following commands:

Previous Show previous day, or week, or month or year.
Next Show next    day, or week, or month or year.
Today Show today.

Data menu commands (Text Documents) 

The Data menu for Text Documents offers the following commands:

Find Find a particular word(s).
Find Next Repeat previous Find selection.
Replace Replace the searched item with the new one 
Select All Select all the document.
Word Wrap Text will wrap around at the edge of the window.
Set Tab Stops Define Tab length.
Set Font Select the font to display document in the screen.
Set Printer Font Set the font used by the printer.
Mirror Display 
Font

Same font in the screen as in the printer.

View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.

Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple 
views of multiple documents in the application window:

Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.
Arrange Icons Arranges icons of closed windows.
Window 1, 
2, ...

Goes to specified window.





Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Index Offers you an index to topics on which you can get help.
Using 
Help

Provides general instructions on using help.

About Displays the version number of this application.



New command (File menu)

Use this command to create a new document in DeskTools.    Select the type of new file you 
want to create in the File New dialog box.    

You can open an existing document with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



File New dialog box

Specify the type of document you wish to create:

Telephone List list of phone numbers, addresses, and notes
Glossary List list of chunk of information sorted by date
Reminder List list of reminders, alarms, calendars and to-do lists
Text Document small text processor 

You can also open an existing document by pressing the Open button.



Open command (File menu)

Use this command to open an existing document in a new window.    You can open multiple 
documents at once.    Use the Window menu to switch among the multiple open documents.  
See Window 1, 2, ... command.

You can create new documents with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



Select Document dialog box

You can create a new document by selecting the desired document type and pressing the 
button Create New. You can also open an existing DeskTools file by pressing the Open 
button. The open dialog box will open up so you can select a file to open.



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you 
select in the List Files of Type box. 

List Files of Type
Select the type of file you want to open:

Telephone Lists .PHN
Glossary Lists .GLS
Reminder Lists .REM
Text Documents .TXT 

Drives
Select the drive in which DeskTools stores the file that you want to open. 

Directories
Select the directory in which DeskTools stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Close command (File menu)

Use this command to close all windows containing the active document.    DeskTools 
suggests that you save changes to your document before you close it.    If you close a 
document without saving, you lose all changes made since the last time you saved it.    
Before closing an untitled document, DeskTools displays the Save As dialog box and 
suggests that you name and save the document.

You can also close a document by using the Close icon on the document's window, as shown 
below:



Save command (File menu)

Use this command to save the active document to its current name and directory.    When 
you save a document for the first time, DeskTools displays the Save As dialog box so you can
name your document.    If you want to change the name and directory of an existing 
document before you save it, choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active document.    DeskTools displays the Save As 
dialog box so you can name your document.    

To save a document with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to 
save:
File Name

Type a new filename to save a document with a different name.    A filename can contain 
up to eight characters and an extension of up to three characters.    DeskTools adds the 
extension you specify in the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four 
documents you closed.    Choose the number that corresponds with the document you want 
to open.



Exit command (File menu)

Use this command to end your DeskTools session.    You can also use the Close command on 
the application Control menu.    DeskTools prompts you to save documents if there has been 
any changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Undo/Can't Undo command (Edit menu)

Use this command to reverse the last editing action, if possible.      The name of the 
command changes, depending on what the last action was.    The Undo command changes to
Can't Undo on the menu if you cannot reverse your last action.

Shortcuts

Toolbar:
Keys: CTRL+Z or

ALT-BACKSPACE



Cut command (Edit menu)

Use this command to remove the currently selected data from the document and put it on 
the clipboard.    This command is unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+X



Copy command (Edit menu)

Use this command to copy selected data onto the clipboard.    This command is unavailable if
there is no data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+C



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point.    This 
command is unavailable if the clipboard is empty.

Shortcuts

Toolbar:
Keys: CTRL+V



Delete command (Edit menu)

Use this command to clear the current selection in the document.    



Preferences command 

Use this command to set preferences particular to this file.    These preferences are for this 
file only. Each file can have its own preferences. 

For additional help see:

Preferences for telephone lists: Preferences-Telephones 
Preferences for glossary lists:    Preferences-Glossaries 
Preferences for reminder lists:    Preferences-Reminders 

Shortcuts
Toolbar:

Keys: CTRL+P



Preferences command (Data menu: Glossary Lists)

Use this command to set preferences particular to this glossary file. 

Show In List As:

Select the most appropriate way to view your glossary list.    

Sort List:

Sort glossary list from A to Z or from Z to A.    

These preferences are for this file only. Each file can have its own set of preferences.      

Shortcuts
Toolbar:

Keys: CTRL+P



Preferences command (Data menu: Reminder Lists)

Use this command to set preferences particular to this reminder file. 

Start Day At:

Select the hour to start your day. This will affect when you Show By Day and when 
you 
print the Daily Format.    

Color Selection:

Basic color selection. The colors will not show unless you place the mouse on top of 
the 
preferences window. Press the button Change Color if you wish to change the color 
selection.    

These preferences are for this file only. Each file can have its own set of preferences.      

Shortcuts
Toolbar:

Keys: CTRL+P



Preferences command (Data menu: Telephone Lists)

Use this command to set preferences particular to this telephone file. 

Show In List As:

Select the most appropriate way to view your telephone list.    

Sort List:

Sort telephone list from A to Z or from Z to A.    

These preferences are for this file only. Each file can have its own set of preferences.      

Shortcuts
Toolbar:

Keys: CTRL+P



Set Printer Font command 

Use this command to select the font to be used by your printer. 

For additional help see:

Set Font for telephone lists: Font-Telephones 
Set Font for glossary lists:    Font-Glossaries 
Set Font for reminder lists:    Font-Reminders 

Shortcuts
Toolbar:

Keys: CTRL+F
 



Set Printer Font command (Data menu: Telephone Lists)

Use this command to select the font to be used by your printer. For compact directories it is 
recommended to use a size no greater than 10.

Shortcuts
Toolbar:

Keys: CTRL+F
 



Set Printer Font command (Data menu: Glossary Lists)

Use this command to select the font to be used by your printer. For diskette labels it is 
recommended to use a size no greater than 12. The title is automatically set to size 24.

Shortcuts
Toolbar:

Keys: CTRL+F
 



Set Printer Font command (Data menu: Reminder Lists)

Use this command to select the font to be used by your printer. 

The title of the calendars is automatically set to size 5/4 the size you choose. This cannot be 
changed. The size of the small calendars at the bottom of the page is set to 3/4 the size you 
select. The font for the calendars is always Courier New. If you do not have this font then 
you may encounter problems printing small calendars. However, this is very unlikely to 
happen. 

Shortcuts
Toolbar:

Keys: CTRL+F
 



Set Dial Settings command (Data menu: Telephone Lists)

Use this command to select your particular settings for dialing out. You can add a prefix to 
the number you wish to dial out. The most important setting is the port to be used. Other 
settings will be used in future versions.

Shortcuts
Toolbar:

Keys: CTRL+X



Merge command (Data menu)

Use this command to merge an existing list into the current list.

Shortcuts
Toolbar:

Keys: CTRL+M



Welcome to DeskTools 

DeskTools is a multiple document application. There are four different documents that can 
be created: 

Telephone Lists
Glossary Lists
Reminder Lists
Text Documents

This is a shareware application which means that you are entitled to use it free for the first 
30 days, after which, you must either pay the shareware fee of $35, or delete the program 
from your hard disk. We appreciate your support and we thank you for supporting the 
shareware concept.

For additional help see: 

How to get in touch with us
How to Register



How to get in touch with us

We are GMIS Associates, a software company developing shareware programs for Windows 
and the Macintosh. Our address is:

GMIS Associates
504 Norcross Way
Silver Spring, MD 20904
(301) 680-0362

You can reach us by e-mail at:

Internet: gmisrod@digex.net
AOL:          gmis
Compuserve: 71612,1123

The internet access is the fastest way to get to us. We welcome your feedback, bug reports, 
wish lists for future versions and constructive criticism. 



How to register DeskTools

Send check or money order for the amount of $35 plus $3 for shipping and handling ($5 
outside the US) to: 

GMIS Associates
504 Norcross Way
Silver Spring, MD 20904

You can use the order form that comes with the archive called order.txt. 

By registering DeskTools you will receive:

*    free technical support    for the first year 
*    a printed manual
*    a diskette with the latest version
*    free updates whenever they come up
*    upgrades at half price
*    a set of sample files

Registration also makes the About Box disappear at start up time and at exit time. Your 
name will show in the About Box after registration whenever you press the button About 
DeskTools.



License Agreement (applicable to registered users)

This software and the disk on which it is contained is licensed to you, for your own use. This 
is copyrighted software. You are not obtaining title to the software or any copyright rights. 
You may not sub license, rent, lease, convey, modify, translate, convert to another 
programming language, decompile, or disassemble the software for any purpose.

You may make as many copies of this software as you need for back-up purposes. You
may use this software on more than one computer, provided there is no chance it will be 
used simultaneously on more than one computer.

Site licenses are available upon request. See the section    How to get in touch with us.



Distribution Conditions

Redistributed copies of this program must be distributed will all files, including this one. The 
archive contents is as follows:

c4dll.dll database routines
ctl3d.dll 3D control routines from Microsoft
desktool.exe DeskTools latest version
desktool.hlp DeskTools on-line help (this file)
readme.txt Readme file with basic information
order.txt Order form

All other files in the archive correspond to the setup program and can be deleted once 
DeskTools has been installed in your hard disk.

The author grants permission for this software to be copied and distributed if no fee is 
charged. Otherwise, you must get written permission from GMIS Associates to distribute 
copies of this software.



Disclaimer

GMIS ASSOCIATES DISCLAIMS ALL WARRANTIES RELATING TO THIS SOFTWARE, WHETHER 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, AND ALL SUCH WARRANTIES 
ARE EXPRESSLY AND SPECIFICALLY DISCLAIMED. NEITHER GMIS ASSOCIATES NOR ANYONE 
ELSE WHO HAS BEEN INVOLVED IN THE CREATION, PRODUCTION, OR DELIVERY OF THIS 
SOFTWARE SHALL BE LIABLE FOR ANY INDIRECT, CONSEQUENTIAL, OR INCIDENTAL 
DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE SUCH SOFTWARE EVEN IF GMIS 
ASSOCIATES HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES OR CLAIMS. IN NO 
EVENT SHALL GMIS ASSOCIATES LIABILITY FOR ANY DAMAGES EVER EXCEED THE PRICE PAID
FOR THE LICENSE TO USE THE SOFTWARE, REGARDLESS OF THE FORM OF CLAIM. THE 
PERSON USING THE SOFTWARE BEARS ALL RISK AS TO THE QUALITY AND PERFORMANCE OF
THE SOFTWARE.

Some states do not allow the exclusion of the limit of liability for consequential or 
incidental damages, so the above limitation may not apply to you.

This agreement shall be governed by the laws of the State of Maryland and shall 
inure to the benefit of GMIS Associates and any successors, administrators, heirs and 
assigns. Any action or proceeding brought by either party against the other arising out of or 
related to this agreement shall be brought only in a STATE or FEDERAL COURT of competent 
jurisdiction located in Montgomery County, Maryland. The parties hereby consent to in 
personam jurisdiction of said courts.



Telephone List (DeskTools Document)

A DeskTools document. You can maintain a list with phone numbers, business and home 
addresses, company name, and miscellaneous notes. 

You can dial out by simply pressing a button. You can print your phone directory in two 
different formats. You can print any size labels, envelopes and rolodex cards. This works in 
matrix printers as well as laser printers.

The number of records is limited only by the size of your hard disk. 

Any telephone list document MUST have extension .PHN.    For each telephone file 
DeskTools generates two additional files with the same name and extensions .DTP (this one 
has the actual data) and another one with extension .DPX (this one is for indexing).

In you would like to move/delete a telephone list you created, you must move/delete all 
three files. Before you do any of this two operations, you must exit DeskTools.



Glossary    List (DeskTools Document)

A DeskTools document. This document is used to store chunk of text up to 4K each. It could 
be used to maintain a list of telephone conversations, contacts, summaries, book reports, 
memos, etc. 

You can store diskette information and then print diskette labels.    

The number of records is limited only by the size of your hard disk. 

Any glossary    list document MUST have extension .GLS.    For each glossary file DeskTools 
generates two additional files with the same name and extensions .DTG (this one has the 
actual data) and another one with extension .DGX (this one is for indexing).

In you would like to move/delete a glossary list you created, you must move/delete all three 
files. Before you do any of this two operations, you must exit DeskTools.



Reminder List (DeskTools Document)

A DeskTools document. This document is used to maintain your appointments, alarms, 
calendars and to-do lists. 

You can print your calendars in four different formats: daily, weekly, monthly and yearly. 

You can set an unlimited number of alarms. You can repeat events daily, weekly, monthly 
and yearly.

The number of records is limited only by the size of your hard disk. 

Any reminder list document MUST have extension .REM.    For each reminder    file 
DeskTools generates two additional files with the same name and extensions .DTR (this one 
has the actual data) and another one with extension .DRX (this one is for indexing).

In you would like to move/delete a reminder list you created, you must move/delete all three
files. Before you do any of this two operations, you must exit DeskTools.



Text Document (DeskTools Document)

A DeskTools document. This document is used to basic word processing. You can type up to 
32K size documents, change fonts, change word wrapping, find, replace, undo, cut, copy and
delete. 

The purpose is mainly to offer you a rapid way to type a small amount of text without all the 
overhead of the big word processors.



Add command (Telephones menu)

Use this command to add a new item to the list.

The limitations on the fields are:

First Name, Last Name and Company 30 characters max (each)
All Telephones 20 characters max (each)
Addresses 500 characters max (each)
Notes 2K characters max 

Shortcuts
Keys: CTRL+A



Delete command (Telephones menu)

Use this command to delete an item from the list. The item must be highlighted before the 
command can take place. A message box asks for confirmation on the deletion. Although the
message box says that this action is undoable, as long as you do not save your changes you 
still have your previous item in the file. To go back, just close the file and answer NO when 
asked if you want to save the changes made.

Shortcuts
Keys: CTRL+B



Find command (Telephones menu)

Use this command to find item(s) in the list. Select the fields in which the search will take 
place. Then type the search item and hit ENTER. If you want the search to be case sensitive 
(i.e., lower cases different from upper cases) check the box Match Case. The search is done
on the selected fields by matching the search item you typed against the entire field. For 
instance, if you typed sam, then names like sam, samuel, hasam, wetsammy will be 
retrieved from the database.

If your list becomes too large to show in the screen a message will alert you that no all items
are in the list. If you wish, for instance, see all items starting with the letter A (as in a phone 
book), check the box Beginning Word ..., type the letter A and hit ENTER. Only items 
starting with the letter A will be retrieved from the database.

Shortcuts
Keys: CTRL+C



Show List command (Telephones menu)

Use this command to toggle between the last Find query and the entire list. 

Shortcuts
Keys: CTRL+Z



Add command (Glossaries menu)

Use this command to add a new item to the list. The date shows the current date by default. 
Enter your title, source and glossary and click the Add button.

The limitations on the fields are:

Title and Source 40 characters max (each)
Glossary 4K characters max

Shortcuts
Keys: CTRL+A



Delete command (Glossaries menu)

Use this command to delete an item from the list. The item must be highlighted before the 
command can take place. A message box asks for confirmation on the deletion. Although the
message box says that this action is undoable, as long as you do not save your changes you 
still have your previous item in the file. To go back, just close the file and answer NO when 
asked if you want to save the changes made.

Shortcuts
Keys: CTRL+B



Find command (Glossaries menu)

Use this command to find item(s) in the list. Select the fields in which the search will take 
place. Then type the search item and hit ENTER. If you want the search to be case sensitive 
(i.e., lower cases different from upper cases) check the box Match Case. The search is done
on the selected fields by matching the search item you typed against the entire field. For 
instance, if you typed sam, then names like sam, samuel, hasam, wetsammy will be 
retrieved from the database.

If your list becomes too large to show in the screen a message will alert you that no all items
are in the list. If you wish, for instance, see all items starting with the letter A (as in a phone 
book), check the box Beginning Word ..., type the letter A and hit ENTER. Only items 
starting with the letter A will be retrieved from the database.

Shortcuts
Keys: CTRL+C



Show List command (Glossaries menu)

Use this command to toggle between the last Find query and the entire list. 

Shortcuts
Keys: CTRL+Z



Add command (Reminders menu)

Use this command to add a new item to the list. You must enter a reminder text of no more 
than    400 characters. 

Date & Time:

You must select the date and time at which the reminder will start and at which it will 
end. 

Category:

In this version DeskTools keeps track of the category selected but does not do 
anything useful with it. We are open to suggestions from registered users as to how 
to use this option.

Alarm:

Set the alarm by checking the box. You can also select a number (0 to 59) of minutes 
the alarm will go off beforehand. The time at which the alarm will go off is defined by 
the From Time. For example, if the From Time shows 11:35 PM and you select the 
alarm to go off 3 minutes beforehand, the alarm will go off at 11:32 PM. A message 
box will pop up showing you the reminder and the time. If DeskTools is minimized, it 
is restored to its original position, and the reminder list shows the current date. 

Important Note: For the alarm to go off the file which contains the record must be open.

Repeat:

Click this button if you wish to repeat this reminder. See help item    How to repeat an 
event

Shortcuts
Keys: CTRL+A



Delete command (Reminders menu)

Use this command to delete an item from the list. The item must be highlighted before the 
command can take place. A message box asks for confirmation on the deletion. Although the
message box says that this action is undoable, as long as you do not save your changes you 
still have your previous item in the file. To go back, just close the file and answer NO when 
asked if you want to save the changes made.

Shortcuts
Keys: CTRL+B



Find command (Reminders menu)

Use this command to find item(s) in the list. The items found will be displayed in the list. 
Double-click on an item to go to where that item was defined.

Shortcuts
Keys: CTRL+C



Add command (To-do menu)

Use this command to add a new item to the list. Select the priority for each task you wish to 
add. You can have the same priority for different tasks.

Shortcuts
Keys: CTRL+J



Delete command (To-do menu)

Use this command to delete an item from the list. The item must be highlighted before the 
command can take place. 

Shortcuts
Keys: CTRL+K



Check command (To-do menu)

Use this command to check item in the list. A checked item means that you did it already. 
You can change the color of both your items in the list and your checked items by using the 
Preferences command.

Shortcuts
Keys: CTRL+I



Previous command (Calendar menu)

Use this command to go to the previous day, week, month or year. The least you can go is 
1/1/1970.

Shortcuts
Keys: CTRL+G



Next command (Calendar menu)

Use this command to go to the next day, week, month or year. The most you can go is 
12/31/2038. 

Shortcuts
Keys: CTRL+H



Today command (Calendar menu)

Use this command to show today's date.

Shortcuts
Keys: CTRL+T



Export File command (File menu)

DeskTools allows    you to export only Telephone and Glossary lists.    Once a Telephone or 
Glossary list is opened and at least one item is entered in the list, the EXPORT FILE 
command shows up in the FILE menu.
 
Use this command to export the file to text format or to a database format. The database 
format is used mainly if you want to import the exported file into another program. Select 
the fields you wish to export, press export, and then select the name of the file you wish to 
save the exported file. It is recommended you add the extension .TXT to this new file. 

Shortcuts
Keys: CTRL+E



Import File command (File menu)

DeskTools allows    you to import only Telephone and Glossary lists.    Once a Telephone or 
Glossary list is opened the IMPORT FILE command shows up in the FILE menu.
 
Use this command to import a file.    Select the fields you are importing, select the delimiters
for fields and records, press import, and then select the name of the file you wish to save the
imported file. 

It is necessary (i.e., mandatory) you add the proper extension to this new file, otherwise you 
will not be able to open it later.

Telephone Lists .PHN
Glossary Lists .GLS

Shortcuts
Keys: CTRL+I



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in DeskTools, such as File Open.    A check mark appears next to 
the menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to many tools used in DeskTools,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To
Open a new document.

Open an existing document.    DeskTools displays the Open dialog box, in which you 
can locate and open the desired file.

Save the active document or template with its current name.    If you have not named
the document, DeskTools displays the Save As dialog box.

Select preferences particular to this file.

Select the font used by the printer.

Select settings for dialing out.

Merge an existing file into the current one.

Print phone directory in compact form.

Print phone directory in expanded form

Print any size labels.

Print any size envelopes.

Print rolodex cards.

Display DeskTools about box with your registration name and copyright notice.

Get help on any item.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state. 
A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the DeskTools window.    To display or hide the 
status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the description
of the toolbar button command you wish not to execute the command, then release the 
mouse button while the pointer is off the toolbar button. This area also shows how many 
items are showing in the list (visible) and how many items are in the entire file.

The middle area shows the current date and time.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Tile Horizontal command (Window menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped 
fashion.



Tile Vertical command (Window menu)

Use this command to arrange multiple opened windows side by side.



Window Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the main 
window.    If there is an open document window at the bottom of the main window, then 
some or all of the icons may not be visible because they will be underneath this document 
window.



1, 2, ... command (Window menu)

DeskTools displays a list of currently open document windows at the bottom of the Window 
menu.    A check mark appears in front of the document name of the active window.    Choose
a document from this list to make its window active.    



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using DeskTools and various types of reference 
information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of 
DeskTools. 

If you have not registered yet, and would like to do so please read the section How to 
Register.

If you registered your copy of DeskTools and received your name and code from us, press 
the button Register. Type your name as it was given to you. This is case sensitive. Then 
type your code and press ENTER. Your name will show up now in the About Box. 

If it did not show up in the about box,    check that your name and code are typed exactly 
the same way it was given to you and try again. If it still does not work contact us.

Shortcut
Toolbar:



Context Help command 

Use the Context Help command to obtain help on some portion of DeskTools.    When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and 
question mark.    Then click somewhere in the DeskTools window, such as another Toolbar 
button.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1
Toolbar:



Title Bar

The title bar is located along the top of a window.    It contains the name of the application 
and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside 
the scroll bars indicate your vertical and horizontal location in the document.    You can use 
the mouse to scroll to other parts of the document.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the DeskTools window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    DeskTools determines 
which window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    DeskTools determines 
which window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the
document Control menu closes only one window at a time.    You can close all windows at 
once with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the DeskTools application instance



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Ruler command (View menu)



Choose Font dialog box

Select a family, size and a style. Click OK. This settings are particular to each file. 



Choose Color dialog box

Press the button Define Custom Colors. Select the color you want to change, select the 
new color. Now, click on Add Custom Color. Click OK to save your changes.



Find command (Edit menu)

Type the word you wish to search for. Click Find.



Find dialog box



Replace command (Edit menu)



Replace dialog box



Repeat command (Edit menu)

Use this command to repeat the last Find command carried out.    

Shortcut
Key: F4



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



How to edit a record

To edit a record that already exists in one of the lists, just double-click on the item and a 
dialog box with all the information will pop-up. Make any changes you wish to make on this 
item and then press Add or simply hit ENTER. If you do not wish to make any changes just 
press the CANCEL button or hit the ESC key.



How to dial out

Once you have items in your telephone list, select one so that the information of such item is
displayed in the dialog box fields. If you have a phone number in one of the boxes named 
Home, Work, and Fax just press the button of the number you wish to dial. 

If your settings are correct a message box will pop-up showing you the number you are 
dialing and asking you to pick up the receiver. Once you pick up the receiver press ENTER or 
click on the OK button. Your connection has been established.

If your settings are not correct, check them out using the Set Dial Settings command.



How to set headers and footers

Some pages such as text documents, phone directories, glossary lists have the option of 
showing a particular header and footer on each page. 

Accelerators for certain options are:

&f file name
&p page number

By selecting a header like &f and a footer like Page &p you will get the name of the file on 
the upper left corner, the time (file or system) on the upper right corner and the page 
number on the center bottom of each page. 

Have empty boxes for the header or/and footer in case you do not want one of them.



How to repeat an event

In order to repeat an event/reminder, press the Repeat button in the Add Item Dialog Box
for reminders. A dialog box will pop-up asking you to select:

How often you want to repeat the reminder:

Select daily, weekly, monthly (by day or by weekday) and yearly (by day or by 
weekday).

Select until when you want to repeat such event:

This date must be greater than the initial date you started with.

Press the Repeat button. Now click on the Add button to add or edit this reminder. A watch-
clock will show you that DeskTools is busy repeating your event.    



How to set an alarm

To set an alarm for a particular reminder make sure your From Date is already set. The 
alarm time depends on this one. Check the box Set Alarm and if you wish, select a number 
of minutes (between 0 and 59) which you want the alarm to go off beforehand. Click on the 
Add button. A reminder with alarm will show an A in parenthesis in the list of reminders: 
(A). 

Once the alarm goes off, by displaying the reminder in a message box, the (A) will disappear
from the reminder item.



Select All (Data menu)

Select the entire document. 



Word Wrap (Data menu)

Use this command to force text to wrap around the window's frame. If this command is 
unable then a horizontal scroll bar allows you to see the document once it goes past the 
right hand side part of the window.



Set Tab Stops (Data menu)

Define how many spaces for each tab. Default is 8 spaces.



Set Printer Font (Data menu)

Define font to be used by your printer. This selection will be saved when you save your file.



Mirror Display Font (Data menu)

This command makes the font used for the screen display the same as the font used to print
documents.



Keyboard Accelerators

Your menu items and your keyboard accelerators change depending on what type of window
is the front most window. Here are the accelerators for all window types:

Common to all lists:

CTRL+N New document 
CTRL+O Open existing document
CTRL+F4 Close window
CTRL+S Save document
CTRL+E Export list
CTRL+I Import list
Alt+F4 Quit/Exit DeskTools
CTRL+P Preferences
CTRL+F Set printer font
CTRL+A Add a record to list
CTRL+B Delete record from list
CTRL+C Find record in list
CTRL+U Edit record
CTRL+Z Show entire/partial list

Telephone Lists:

CTRL+D Edit dial out settings
CTRL+M Merge lists
CTRL+V Print compact telephone directory
CTRL+X Print expanded telephone directory
CTRL+L Print labels
CTRL+H Print envelopes
CTRL+R Print rolodex cards

Glossary Lists:

CTRL+M Merge lists
CTRL+G Print glossary list
CTRL+L Print diskette labels

Reminder Lists:

CTRL+G Previous date CTRL+J Add task to to-do list
CTRL+H Next date CTRL+K Delete task from to-do list 
CTRL+T Today CTRL+I Check task
CTRL+D Print daily calendar
CTRL+W Print weekly calendar
CTRL+M Print monthly calendar
CTRL+Y Print yearly calendar







Print command (File menu)

Use this command to print a document.      This command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that DeskTools is sending output to the 
printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed.    When 
you choose this command, the main window will be replaced with a print preview window in 
which one or two pages will be displayed in their printed format.    The print preview toolbar 
offers you options to view either one or two pages at a time; move back and forth through 
the document; zoom in and out of pages; and initiate a print job.



Print Preview toolbar

The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)

Some pages such as text documents, phone directories, glossary lists have the option of 
showing a particular header and footer on each page. 

Accelerators for certain options are:

&f file name
&p page number

By selecting a header like &f and a footer like Page &p you will get the name of the file on 
the upper left corner, the time (file or system) on the upper right corner and the page 
number on the center bottom of each page. 

Have empty boxes for the header or/and footer in case you do not want one of them.



Print Compact Directory command (File menu)

Use this command to print a compact    directory. This directory will print your phone 
numbers only in two column format. You can select Portrait or Landscape mode. 

For best results select a Font of size no greater than 10. However, you can try different 
options and decide on the best one for your particular printer.

Shortcuts
Toolbar:

Keys: CTRL+V



Print Expand Directory command (File menu)

Use this command to print a expanded    directory. This directory will print your phone 
numbers only in a one column format. You can select Portrait or Landscape mode. 

Shortcuts
Toolbar:

Keys: CTRL+X



Print Labels (File menu)

Use this command to print any size label. The options are as follows:

Define Labels (in inches):

Height & Width: to select this two read the label's package and input those here.

Labels Per Row: For matrix printers this value is usually 1.
 For lasers printers it usually goes from 1 to 4.

Define Margins:

Top: For matrix printers this value is usually 0.
For laser printers this value is usually 0.5 (half an inch).

Left: For any printer this value is usually 0.

In Between Labels:This is the space between labels vertically. 
For    matrix printers this is usually    1/16.
For laser printers this is usually 0.

Print:

Select    the entire list or the selected item only. If you select Selected Item and 
there is no

 one selected, then by default the first one in the list is printed.

Select Output:

Select the fields you wish to show in your labels as well as the appropriate address.

Select Alignment:

Check either left aligned or center aligned.

Once this settings are defined they are saved with the file for future printing, so next time 
you wish to print labels your settings are already defined. However, this settings are 
particular to this file. If you open a new Telephone List you must define your settings again.

Shortcuts
Toolbar:

Keys: CTRL+L



Print Envelopes command (File menu)

Use this command to print any size envelope. The options are as follows:

Define Envelop:

Select here the width and height of your envelopes (in inches).

Special Message:

There are some pre-defined messages. However, you can type your own one and it 
will stay there until you select a new one. Let us know if you wish to see other pre-
defined messages 

in this list.

Select Output:

Select the fields you wish to show in your envelop    as well as the appropriate 
address.

Select Alignment:

Check either left aligned or center aligned for the address.

Return Address:

Enter here your return address. You can select a different font for the return address 
by 

pressing the Set Return Address Font button.

Select Return Address Alignment:

Check either left aligned or center aligned for the return address.

Print:

Select    the entire list or the selected item only. If you select Selected Item and 
there is no

 one selected, then by default the first one in the list is printed.

Once this settings are defined they are saved with the file for future printing, so next time 
you wish to print envelopes your settings are already defined. However, this settings are 
particular to this file. If you open a new Telephone List you must define your settings again.

Before Printing:

Make sure you select the Print Setup command before printing and select the 
following 

options: landscape, manual feed and envelopes.

Shortcuts
Toolbar:

Keys: CTRL+H





Print Rolodex command (File menu)

Use this command to print any size Rolodex card. The options are as follows:

Define Rolodex (in inches):

Height & Width: to select this two read the label's package and input those here.

Labels Per Row: For matrix printers this value is usually 1.
 For lasers printers it usually goes from 1 to 4.

Define Margins:

Top: For matrix printers this value is usually 0.
For laser printers this value is usually 0.5 (half an inch).

Left: For any printer this value is usually 0.

In Between Rolodexes: This is the space between labels vertically. 
For    matrix printers this is usually    1/16.
For laser printers this is usually 0.

Print:

Select    the entire list or the selected item only. If you select Selected Item and 
there is no

 one selected, then by default the first one in the list is printed.

Once this settings are defined they are saved with the file for future printing, so next time 
you wish to print labels your settings are already defined. However, this settings are 
particular to this file. If you open a new Telephone List you must define your settings again.

In this format DeskTools will print all the information there is for each particular record. This 
is the only way (other than exporting to text) to print all fields in the database for each 
record.

Shortcuts
Toolbar:

Keys: CTRL+R



Print Glossary command (File menu)

Use this command to print your glossary list. 

Shortcuts
Keys: CTRL+G



Print Diskette Labels command (File menu)

Use this command to print 3.5' diskette labels. The options are as follows:

Define Labels (in inches):

Height & Width: to select this two read the label's package and input those here.

Labels Per Row: For matrix printers this value is usually 1.
 For lasers printers it usually goes from 1 to 4.

Define Margins:

Top: For matrix printers this value is usually 0.
For laser printers this value is usually 0.5 (half an inch).

Left: For any printer this value is usually 0.

In Between Labels:This is the space between labels vertically. 
For    matrix printers this is usually    1/16.
For laser printers this is usually 0.

Print:

Select    the entire list or the selected item only. If you select Selected Item and 
there is no

 one selected, then by default the first one in the list is printed.

Select Alignment:

Check either left aligned or center aligned for the title, date and glossary. The title is 
always centered.

Select Output:

Select the fields you wish to show in your labels as well as the appropriate address.

Once this settings are defined they are saved with the file for future printing, so next time 
you wish to print labels your settings are already defined. However, this settings are 
particular to this file. If you open a new Telephone List you must define your settings again.

Shortcuts
Keys: CTRL+L



Print Daily Calendar command (File menu)

Use this command to print a calendar in daily format.    The to-do list    is always printed.    
The options are as follows:

Select Printing:

Agenda Type:

Select this one if you wish to see your day as in an agenda with time breaks 
every 

half an hour. 

Screen Type:

Select this format if you wish to print your day as it shows in the screen. 

Print Small Calendars At Bottom of Each Page:

Decide whether you want small calendars with the previous, today and next months 
at

the bottom of the page. These calendars are always printed in Courier New Font 
regardless of the font chosen for the calendar. 

Shortcuts
Keys: CTRL+D



Print Weekly Calendar command (File menu)

Use this command to print a calendar in weekly format. The options are as follows:

Select Printing:

The Week On One Page:

Select this one if you wish to print the entire week in one page.

The Week, One Day Per Page:

Select this format if you wish to print the week one day per page (7 pages). 

Print Small Calendars At Bottom of Each Page:

Decide whether you want small calendars with the previous, today and next months 
at

the bottom of the page. These calendars are always printed in Courier New Font 
regardless of the font chosen for the calendar. 

Shortcuts
Keys: CTRL+W



Print Monthly Calendar command (File menu)

Use this command to print a calendar in yearly format. The options are as follows:

Select Printing:

The Month On One Page:

Select this one if you wish to print the entire month in one page.

The Month, One Week Per Page:

Select this format if you wish to print month one week per page. DeskTools
 calculates how many weeks are necessary to print the entire month.

Print Small Calendars At Bottom of Each Page:

Decide whether you want small calendars with the previous, today and next months 
at

the bottom of the page. These calendars are always printed in Courier New Font 
regardless of the font chosen for the calendar. 

Shortcuts
Keys: CTRL+M



Print Yearly Calendar command (File menu)

Use this command to print a calendar in yearly format. The options are as follows:

Select Printing:

The Year On One Page:

Select this one if you wish to see print a whole year in one page.    

The Year, One Month Per Page:

Select this format if you wish to print your year as 12 pages, one month per 
page. 

Print Small Calendars At Bottom of Each Page:

This option is valid only if you selected    a The Year, One Month Per Page.

Shortcuts
Keys: CTRL+Y



Print Calendars 

Select one for additional help on the desired format:

How to print daily calendars
How to print weekly calendars
How to print monthly calendars
How to print yearly calendars




